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1. How to install the application?

Review the installation guide to see how to see how to install “Denial of Service Attack
Detector & Tracer (DoSAT)” and all the required software and libraries.

2. How to run the application?

2.1 Run From the Source Code (NetBeans Application).

Either by clicking run button as shown below.
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Or from the Run Menu, choose “Run Main Project” Menu Item as shown below:
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2.2 Run From the Jar File

Or just by double clicking the manager.jar file and the application will run. This is shown
next.
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The program starts with the following screen
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Show Dynamic Chart

3. How to configure database connection?

First thing, you should do, if you are using the application for the first time, is to
enter the database parameters. These are the parameters about the database you have
already installed in your system and you also have the database tables running there.

From the configure menu, in DoSAT application, choose “Database Connection
Properties” menu item. This is shown in the next diagram.



Add /| Remove Router / Subnet...

Add / Remove Connection...
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Status Mo attack

Tracing
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A dialog box will appear. This is show in the following diagram.

User Mame | |

Password | |

Service | |

Host | |

Port | |

OK Cancel

The user can enter the username, password, service, host and port number, i.e. all
the information required to connect to specific database. The system will remember the
old configuration of the database. This is shown below.



User Name |scot |

Password [sesue |

Service lorel |

Host \Salam |

Port 522 |
OK Cancel

4. How to connect to database?

After you have configured your database, you can connect to it by choosing “Connect”
menu item from the “File” menu. This is shown below.
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If it connects successfully, it just displays the routers stored before in the database and
you can continue working with the application.
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If you have entered wrong parameters in the database configuration, and the system is not
able to connect to the database, the system will display a message that it cannot connect
to the database.

5. How to add a node?

To add a node whether it is router or subnet, go to “Add/Remove Router/Subnet” menu
item from the “Configure” menu as shown below:
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The following dialog will appear

@) Router ) Subnet 172.16.0.1
172.16.0.0
Address |
Add
Remove
Close

To add a router just choose Router radio button and enter the address (identity) of the
router which is one of the IPs of its interface and then click the add button. This is shown
below.



@ Router ) Subnet 127.0.0.1
172.16.0.1
172.16.0.0

Address  |127.0.0.1

Add
T Remove

Close

Then you can choose the close button to dispose this dialog.

If you try to add a router/subnet without entering the address, the following error message
appears.

-
L PN SN S El:

@ Please enter an IP address of the router/subnet

oK

If you try to add the a router/node more than once, the following error appears

3

6. How to remove a node?

To remove a node whether it is router or subnet, go to “Add/Remove Router/Subnet”
menu item from the “Configure” menu as shown below.
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etection
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Status Mo attack
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The following dialog will appear

eSS ddRempyeRouter/Subnet

@) Router ) Subnet 127.0.0.1
172.16.0.1
172.16.0.0

Address |

Add
Remove
Close

You need to select the IP address of the router or the subnet and then click remove. This
is shown below.
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BN AddiRemoye Houter/Subnets

@ Router ) Subnet 127.0.0.1
172.16.0.1
Address |
Add
Remove
Close

And then, after you click remove, the following screen is shown.

EY AddiRemoye Houter/Subnet:

® Router 7 Subnet 127.0.0.1
172.16.0.1
Address |
Add

Close

If you try to remove a node without selecting one the following error appear.

ol enesniontenSuhnet

@ Please Select a router/subnet to remove

oK

12



If you try to remove a node that has a connection to other node, or has some traffic data
stored about it in the database, then the following error appears.

Frror Deleting Node x|

® Node Cannont be deleted, please remove old data, and any connection uses this node

OK

7. How to add a connection?

For each router you have a number of interfaces. For each connected interface in all
routers, user has to enter to where this interface is connected. To add a connection, go to
“Add/Remove Connection” menu item in the “Configure” menu. This shown below:

E2Denial ofiSenvice Attack-Detectorand dracer: Lj _ﬂ m'

 File | Configure | Help
latabase C tix erties
M Database Connection Properties v
Add /| Remove Router ! Subnet...
Add / Remove Connection... Status Mo attack
Delete old data
Set Thresholds...
3
4 Tracing
Path

Show Dynamic Chart

After you click the following dialog appear.
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ESNddiRemove Conneciion ﬁi
Router interface  Rouwter/Subnet interface
127.0.0.1 - | 127.0.0.1 -
Add
Remowve
Close

Choose a router in the first compo box, enter which interface and then choose another
router (you need to say which interface) or subnet (you do not need to enter any interface)
the first router is connected to and then click “Add” button. The connection between
routers needs to be represented in both directions. How to add a connection is shown
below.
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Router interface  Rouwter/Subnet interface

172.16.0.1 v [1 | |172.16.00 JN

Remowve

Close

If you try to add a connection that connects a router to itself the following error appears.

EroraddinE e conECHon

@ Cannot connect a router to itself

oK

If you try to add a connection that exists already, the following error appears.

Enroraddinga connection

a Could not add a connection, please make sure you are not trying to add a duplicate copy of the connection

If you try to add a connection to a router without entering the interface number the
following error appear.
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@ Please enter a number as interface for the connection

oK

8. How to remove a connection?

To remove a connection, go to “Add/Remove Connection” menu item in the “Configure”
menu. This shown below.

EADemiallorService AttanicD stactorand i racers

File » | Help
M Database Connection Properties Eettion
Add / Remove Router / Subnet...
| Add/Remove Connection... |status No attack
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3
4 Tracing
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Show Dynamic Chart

After you click the following dialog appear.
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BN Addiempye Connection:

Router interface  Rouwter/Subnet interface
7 Y 1 —
Add

Mode1: 172.16.0.1, Imerface1: 1, Node2: 172.16.0.0, Interface?: 0

Remowve

Eluse_

Then you have to choose the connection you want to delete and then click on the
“Delete” button, as shown below.
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Router interface  Router/Subnet
127.0.0.1 - | 127.0.0.1
Add

interface

Remowve
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E2Addemove Connection ﬁ

Router interface  Rouwter/Subnet interface

127.0.0.1 > | [127.0041 =] |

Add

Remowve

Close

If you try to remove a connection without selecting one, the following error appears.

OOV O CE m-.

® Please Select a Connection to Remove

OK

9. How to delete old data?

When you monitor the routers, all the traffic rate data for all interfaces in all routers per
specific amount of time are stored in the database. If you want to delete this data from the
database just go to “Delete Old Data” menu item in the “Configure” menu as shown
below.
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Database Connection Properties
Add / Remove Router / Subnet...
Add | Remowve Connection... Status Mo attack

etection

Set Thresholds...
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4 Tracing
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Show Dynamic Chart

After you click “Delete old data”, all the data will be deleted and you get the following
message.

SIECESEN Ve TR LT T Ve

® All old data in the database are deleted

oK

10. How to update threshold values?

The user is allowed to configure how the program works by updating some thresholds
values. To display the dialog that enables updating threshold values, from the
“Configure” menu, click on “Set Thresholds...” menu item as shown below.
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The thresholds dialog appears with some default values.
EXhresholds m‘
Interval Monitoring |3':|| | seconds
Max time to Attack 10 | minutes
Maximum Normal Traffic 140000 | octet per second

Minimum Correlation Coefficient |':'-7“'5

OK

Cancel

As we can see, the user can update the “Interval Monitoring” which is how long in

seconds the system should waits between two successive requests to routers. The “Max
time to Attack” is how long the attack is allowed to proceed before the tracing is started.
The “Maximum Normal Traffic” is the maximum traffic acceptable to consider that there
is no attack, if the traffic rate exceeds this threshold then the system consider that there is

an attack. The “Minimum Correlation Coefficient” is the minimum correlation value

acceptable to consider two traffic patterns as correlated. You can update any value you
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want and then click “OK” button. You may click “Cancel” button if you do not want to
change the previous value.

11. How to start monitoring?

After you are connected to the database, and you have supplied the system with all the
needed topology and thresholds information, you can start the system by clicking “Start”
menu item from the “File” menu. The system after clicking *“Start” starts monitoring
network by sending requests and receiving responses from routers.

EdDemallofiservice Attacklietecior and Miracer Lj _._.j ai

File | Configure Help

eHEREES Detection
Start
Exit i) Duk Status Mo attack
127.0.0.1 1 |
172.16.0.1 2
3
4 Tracing
Path

Show Dynamic Chart

If you try to start the application without having any router, the following error message
appears.

1

oS taniang) mi

® There is not a single rowuter, please add routers/subnets

OK
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12. How to exit the system?

You can exit the system at any time by choosing “Exit” menu item from the “File” menu,
as shown below.

EdDeniallofiSernvice Attacklietector and Miracer: Lj _.__; a‘

File | Configure Help
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e g Detection
Start
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4 Tracing
Path
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After that a confirmation message is displayed.

L —
Bt Copiflrpaiilg ai

? Are you sure you warnt to Exit?

Yes No

If you click “Yes”, the system will exit, if you click “No” nothing will happen.

13. How to get dynamic chart feedback?

You can get dynamic chart of any of the monitoring interfaces in all routers. Make sure
that the monitoring is started and you select router address, interface number, and the
type whether it is “in” or “out”.
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If you try to get feedback and the application is not started or not selecting an address or
an interface the following error appears.

ErroranshowinglynamicEharnt
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14. How to get detection information?

The detection information can be displayed whether there is an attack or there is not in
the upper right corner. This is shown in the next diagram.

Detection

Status There is Attack
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15. How to get tracing information?

You can get the Traced path from which subnet to any other subnet in the network going
through a number of routers from the lower right corner. This is shown in the next figure.

1721600 17216.01,172.20.0.1,
172.2000.0}

16. How to get Information about the system designer
and programmer and his supervisor?

From the “Help” menu go to “About” menu item this is shown below.
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E2 Denial ofiService Attack Detector and diracer.

E[EX

File Configure | Help

Show Dynamic Chart

ut
Monitoring i Detection
s In i) Out Status Mo attack
1
2
3
4 Tracing
Path

After you click the following screen will be displayed.

z

= e

Done by: Supervised by:

Ahmad Salam AlRefai

a.s.refai@gmail.com

Dr. Mohammad Sqalli

sqalli@ccse.kfupm.edu.sa
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